About BootMagic

PowerQuest’s BootMagic is a powerful disk-management tool that helps you run multiple operating systems
(OSs) on a single PC. Each time you start your computer, BootMagic presents a list of operating systems, letting
you select the OS you want to boot. BootMagic also contains a configuration option that lets you quickly select
those OSs you want to appear as boot-up choices. With BootMagic, you can switch between OSs, using
whichever OS best suits your immediate needs. You can even try out a new OS risk-free, knowing that your old
OS is there, readily accessible when you need it.

Supported operating systems

BootMagic Features

Windows 95, 98,

Me, and Windows
NT 3.51, 4.0, and
2000

MS-DOS 5.0 or later

Open DOS

Linux
0S/2 3.0 or later

Windows 3.x
(must be
installed with
DOS 5.0 or later)
PC-DOS 6.1 or
later

Most other
versions of DOS
BeOS

Some other PC-
compatible OSs

e Support for FAT - You can install to any FAT16, FAT16X, FAT32, and FAT32X primary partition.

e Password-protection - You can a set up a password for the entire BootMagic Menu or for each operating system
listed on the BootMagic Menu. You can also assign a password to the BootMagic configuration program.

e Custom background - You can add your own bitmap image to the background of the BootMagic Menu screen.

e Boot from secondary disk - You can boot operating systems installed on secondary hard disks.

{button JI(*',"H_How_Does_BootMagic_Work_')} How does BootMagic work?

{button JI("',"H_After_Installing_BootMagic')} After installing BootMagic

{button ,JI("',"H_To_start_the_BootMagic_configuration_program')} To launch the BootMagic configuration

program



How Does BootMagic Work?
BootMagic is composed of two primary parts: the BootMagic Menu and the BootMagic configuration program.

BootMagic Menu

Each time you start your computer, the BootMagic Menu appears, so you can select from multiple operating
systems installed on your system.

A timer in the lower-right corner of the BootMagic window displays the user-defined startup delay. This time
counts down the seconds until BootMagic automatically starts the default OS. If you move your mouse or press
a key on the keyboard, the timer stops and BootMagic waits until you make a menu selection.

Once you choose the desired OS, BootMagic loads the OS’s boot record into memory, hides and unhides any
necessary partitions, and marks the OS’s associated partition as active. BootMagic then launches the OS and
disappears, all without affecting the OS in any way.

BootMagic works by replacing your system’s MBR (Master Boot Record) with its own custom master boot
record. Although the original MBR is completely removed, the BootMagic MBR retains all of the current
partition table information on your existing OSs. BootMagic also makes a backup copy of the original MBR in
case you need to disable or uninstall BootMagic.

After installation, BootMagic sorts through all your system’s hard disks, looking at the partition tables and
gathering information about each currently installed OS. BootMagic then automatically runs the configuration
program, adding every detected OS to the BootMagic Menu.

When you start your computer after installing BootMagic, the system BIOS loads and runs the BootMagic MBR,
which, in turn, loads and runs the BootMagic Menu.

BootMagic Configuration Program

You can run BootMagic’s configuration program from either the Program group on the Windows taskbar or from
the Tools pull-down menu in PartitionMagic. The configuration program lets you specify which OSs appear in
the BootMagic Menu and lets you set various boot-time options such as a default OS and a startup delay.
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The BootMagic Runtime Menu group box lists all the OSs available as boot up choices when you start your
computer; there are six in the illustration above. The Menu Name column displays the user-specified name for each



OS and the Default column identifies which OS is the system default.
The BootMagic configuration program is available to you in a DOS version or in a Windows 95/98/NT version.
Both versions look and function the same way.



After Installing BootMagic

After installation, BootMagic sorts through your system’s hard disks, looking at the partition tables and gathering
information about each currently installed operating system. BootMagic then automatically runs the
configuration program, adding every detected OS to the BootMagic Menu.

At this point, you may need to edit the OSs in the menu list. While BootMagic reliably detects most OSs, it may
also detect some non-0OS partitions. For example, if you have a primary NTFS data partition on the first disk,
BootMagic may detect it as Windows NT. Likewise, an HPFS data partition may be detected as 0S/2, and a FAT16
or FAT32 data partition may be detected as MS-DOS or Windows 95/98. Because these non-0S partitions cannot
be booted, you should removed them from the menu list. You can also choose to add or remove other OS
selections, modify OS names and icons for easier identification, set a new startup delay, or select a different
default OS.

For information on identifying non-0S partitions in the menu list, click See Also on the Help toolbar. For more
information on the BootMagic configuration program, select Contents from the help menu bar and open the
Configuring BootMagic book in the Help Topics outline.

After you make any necessary changes, click Save/Exit. The next time you reboot your computer, the
BootMagic Menu appears. To start an OS, select the menu item you want to start.



To start the BootMagic configuration program

1 From the Windows taskbar, click Start » Programs
» PowerQuest BootMagic
 BootMagic Configuration.
Tips
e From PartitionMagic, click Tools ¥ BootMagic Configuration.
e From a DOS prompt, type drive:\BTMAGIC.PQ\CONFIG.BAT (replace drive with the drive letter where
CONFIG.BAT is located), then press <Enter>.

e For more information on the BootMagic configuration program, select Contents from the help menu bar and
open the Configuring BootMagic book in the Help Topics outline.



About BootMagic Enabled

Use BootMagic Enabled to turn BootMagic on or off. This option must be enabled (selected) for the configuration
options to be available. If you disable BootMagic, the default operating system is automatically booted when you
start your computer (or until you enable BootMagic again).

You may want to consider disabling BootMagic if you are diagnosing an OS startup problem and need to reboot
your system multiple times. This will let you bypass loading BootMagic every time. Disabling BootMagic replaces
the BootMagic MBR (master boot record) with a copy of your original MBR. When you reboot your computer,
BootMagic no longer loads and the default OS is automatically booted.

Disabling BootMagic does not destroy any of your configuration settings. All of the current settings are saved
until BootMagic is enabled again.

{button ,JI("',"H_To_disable_BootMagic')} To disable BootMagic



To disable BootMagic
1 From the BootMagic configuration program, click File » BootMagic Enabled.
2 Click File » Save/Exit to save your changes and exit the configuration program.

BootMagic remains disabled until you enable it again. To enable BootMagic, run the configuration program
from either your hard disk or the BootMagic rescue disk. Select the BootMagic enabled check box in the
BootMagic configuration window. When BootMagic is enabled, it saves a copy of the current MBR, then
reinstalls the BootMagic MBR. Upon reboot, BootMagic loads normally, and all the previous configuration
settings are restored.

Tips
¢ To enable BootMagic, you can run the BootMagic configuration program from the Windows taskbar (click Start

» Programs

» PowerQuest BootMagic
r BootMagic Configuration, or from the BootMagic rescue diskette (follow the on-screen instructions to start the
BootMagic configuration program). Select BootMagic Enabled, then click Save/Exit.



About Create Rescue Diskette

During installation of BootMagic, you were given the option to create a BootMagic rescue diskette. This diskette
is vital if your system's MBR (master boot record) is damaged or overwritten. The diskette can also be helpful if
you disable BootMagic and cannot access the configuration program to enable it.

If you did not create a rescue diskette during installation, you should do so now. PowerQuest technical support
may not be able to help you if you have not created a rescue diskette.

{button ,JI("',"H_To_create_rescue_diskettes')} To create rescue diskettes



To create rescue diskettes
1 From BootMagic configuration program, click File  Create Rescue Diskette, then follow the on-screen

instructions.

Tips

o After the BootMagic DOS install, DOS users should run C:\BTMAGIC.PG\MKRESCUE.BAT at a DOS prompt to
create the rescue disks.



About Creating an Operating System Boot Diskette

Boot diskettes are an invaluable tool for diagnosing and repairing certain OS problems. Some OSs, such as
Windows 95/98 and Windows NT, give you an opportunity to create a rescue boot diskette during installation.
This is the diskette that should be used if you ever experience OS failure.

DOS does not automatically provide an option for creating a boot diskette. However, you can easily create a boot
diskette for DOS. You can also create a boot disk for Windows 95/98, if necessary.

{button ,JI(*',"H_To_create_an_operating_system_boot_diskette')} To create an operating system boot diskette



To create an operating system boot disk
1 Insert a blank, formatted disk into drive A.

2 From the Windows taskbar, click Start » Run.

3 Type sys A: in the Open text box, then click OK.
4 Copy the following files from your hard disk to the A: drive: SYS.COM, EDIT.COM, FDISK.EXE, FORMAT.COM,

and ATTRIB.EXE.
In Windows 95/98, these files are usually located in the \WINDOWS\COMMAND subdirectory. In DOS, these files

can be found in the \DOS subdirectory.

Tips

¢ If you are running DOS, type sys a: at the DOS prompt, then press <Enter>. The system files are copied onto
the floppy disk.

¢ You may also want to copy additional files, such as a CD-ROM driver, SCANDISK.EXE, CHKDSK.EXE, or
XCOPY.COM. These files extend the capabilities of your boot diskette.

e Be sure to write-protect the disk and clearly label it for easy identification.



About Cancel
Use Cancel to discard all configuration changes and exit BootMagic.
{button ,JI(*',"H_To_cancel_your_configuration_changes')} To cancel your configuration changes



To cancel your configuration changes

1 From the BootMagic configuration program, click File ¥ Cancel.
2 Click No to cancel your changes and exit.



About Save/Exit
Use Save/Exit to save all configuration changes you have made and exit the BootMagic configuration program.
{button ,JI(*',"H_To_save_and_exit_BootMagic')} To save and exit BootMagic



To save and exit BootMagic
1 From the BootMagic configuration program, click File » Save/Exit.

Tips
¢ You can also click Save/Exit, or you can right-click in the BootMagic Runtime Menu group box, then select

Save/Exit.



About Add

The BootMagic Menu appears each time you start or restart your computer, listing all bootable operating
systems. You can use Add in the BootMagic configuration program to add an operating system to the menu.
{button ,JI("',"H_To_add_an_operating_system_to_the_BootMagic_menu')} To add an operating system to the
BootMagic Menu



To add an operating system to the BootMagic Menu
1 From the BootMagic Configuration program, click Edit» Add.
The BootMagic Add OS dialog box lists all the system OSs detected by BootMagic.

Colu Description

mn

Headi

ng

Used Specifies whether the

OS partition is already
included in the
BootMagic Menu.

oS Displays the detected

Name name for the operating
systems. If no OS is
detected, or if
BootMagic is unable to
identify the OS, this
column displays
Unknown.

BootMagic may
sometimes detect an
OS that does not exist
or may detect the
wrong name for an
existing OS. For help on
finding the operating
system and partition
you want, click See
Also on the Help

toolbar.
Volum Lists the name
e assigned to the
Name partition.
Partiti Identifies the
on partition’s file system
Type type (for example,

FAT16, FAT32, NTFS,
HPFS, Ext2, and so on).
If the partition is an
extended partition, its
partition type is listed
as Extended.

Disk Specifies the system
hard disk on which the
partition is located (for
example, 1 is the first
hard disk, 2 is the
second, and so on).

Partiti Identifies the partition

on as either Primary (Pri)
or Logical (Log) and
also identifies its



location on the hard
disk (for example, Pri-2
is the second primary
partition, Log-1 is the
first logical partition,
and so on).

2 (optional) Select Advanced to view all your system’s partitions, including those that BootMagic does not
recognize as containing an OS

3 Select the OS you want to add to the BootMagic Menu.
Do not add non-0OS partitions to the BootMagic Menu. You cannot boot your computer from a partition without
an OS. If you add a partition that does not have an OS and try to boot, you will be left with a black screen.

4 Click OK.

5 Define the menu properties you want, and then click OK.
The OS appears in the BootMagic Runtime Menu list and will appear as a boot-up choice the next time you
start your computer.

Tips

¢ In step 1 you can also click Add, or you can right-click in the BootMagic Runtime Menu group box, then select
Add.

e The Advanced option is useful if BootMagic does not detect an OS you want to add to the BootMagic Menu. For
more information on finding the right operating system and partition you want, click See Also on the Help
toolbar



About Delete

Use Delete to remove a selected operating system from the BootMagic Runtime Menu list. This option does not

delete the operating system from the hard disk, nor does it prevent the operating system from being added
again to the menu.

{button ,JI("',"H_To_delete_an_operating_system_from_the_BootMagic_menu')} To delete an operating system
from the BootMagic Menu



To delete an operating system from the BootMagic Menu

1 From the BootMagic configuration program, select the OS name you want to delete from the BootMagic
Runtime Menu list.

2 Click Edit » Delete.

Tips

e In step 2, you can also click Delete, or you can right-click in the BootMagic Runtime Menu group box, then
click Delete.

¢ Deleting an OS from the BootMagic Menu does not remove the OS from the hard disk. The OS remains in its
partition.



About Set as Default

Use Set as Default to specify which operating system you want to use as the system default. BootMagic
automatically selects the OS in the home partition (that is, the partition in which BootMagic is installed) as the
system default. This is the OS that BootMagic automatically boots if no other OS is chosen before the startup
delay expires, if the startup delay is set to None, or if you disable BootMagic.

{button ,JI("',"H_To_specify_the_default_operating_system')} To specify the default operating system



To specify the default operating system

1 From the BootMagic Configuration program, select the OS you want to set as the system default.
2 Click Edit » Set as Default.

Tips

e In step 2, you can also click Set as Default, or you can right-click in the BootMagic Runtime Menu group box,
then select Set as Default.



About Properties

Use Properties to view or edit the selected operating system's runtime menu properties. For example, you can
review, among other things, the selected OSs name, volume name, and partition type. You can the change
operating system's name that appears on the BootMagic Menu, assign a password to menu name, or change the
icon that represents the selected OS.

You can also use Properties to identify which primary partitions on the first disk are visible when the selected OS
is booted. Visible partitions are checked; hidden partitions are not.

{button ,JI("',"H_To_choose_general_menu_item_properties')} To choose general menu item properties
{button ,JI("',"H_To_choose_visible_partition_properties')} To choose visible partition properties



To choose general menu item properties

1 From the BootMagic configuration program, select the OS whose properties you want to change, from the
BootMagic Runtime Menu list box.

2 Click Edit » Properties

¥ General.
3 Type a name for the selected OS, in the Name text box.

The name you type will appear on the BootMagic Menu at startup.

4 Click Set Password to assign a password to the OS that appears on the BootMagic Menu. The password is
used when you select the OS on the BootMagic Menu that you want to boot.

5 Type your old password (if available).
6 Type your new password, then type it again in the Confirm new password text box.
7 Click OK.
8 Click Change Icon.
9 Navigate to the BootMagic ICO folder.
10 Choose an icon for the selected OS.
The icon you select will appear on the BootMagic Menu at startup.
11 Click OK.

Tips
¢ In step 1, you can also right-click in the BootMagic Runtime Menu group box, then click Properties.

e In step 10, you can use any 16-color, 32x32 pixel icons with a .ICO file extension.

¢ You can also set passwords for the BootMagic configuration program itself and for the BootMagic Menu at
startup.

¢ To disable the password setting, follow steps 1 and 2 above, but do not enter a new password.
¢ The General tab also contains the following information for your review:
Na Purpose
me
0s Displays the user-
defined name for the

Os.
Vol Specifies the name
um assigned to the
e partition.
Na
me
Par Specifies the partition’s
titi file system type (for

on example, FAT16, FAT32,

Typ NTFS, HPFS, Ext2, and

e so on). If the partition
is an extended
partition, its partition
type is listed as

Extended.
Dis Specifies the system
k hard disk on which the

partition is located (for
example, 1 is the first
hard disk, 2 is the
second, and so on).



Par
titi
on

Specifies the partition
as either Primary (Pri)
or Logical (Log) and
also identifies its
location on the hard
disk (for example, Pri-1
is the first primary
partition, Log-2 is the
second logical
partition, and so on).



To set menu item password

1 From the BootMagic configuration program, select the OS whose properties you want to change, from the
BootMagic Runtime Menu list box.
2 Click Edit » Properties

¥ General.

3 Click Set Password to assign a password to the OS that appears on the BootMagic Menu. The password is
used when you want to boot the selected OS.

4 Type your old password (if available).

5 Type you new password, then type it again in the Confirm new password text box.
6 Click OK.



To choose visible partition properties

1 From the BootMagic configuration program, select the OS in the BootMagic Runtime Menu list box whose

properties you want to change.

2 Click Edit » Properties
¥ Visible Partitions.

3

Select the disk containing the primary partitions you want to make visible, from the Disk drop-down list.

This option is dimmed (unavailable) if you have not enabled (selected) Advanced Partition Hiding on the Options
pull-down menu.

4 Select Override Default Selections.

5 Select the primary partitions you want to make visible, or deselect the partitions you want to hide. If you need

to make a primary partition visible, you should be aware that with some OSs (such as Windows 95/98 and
0S/2), making a second primary partition visible can cause errors and data loss.

Tips

L]

In step 1, you can also right-click in the BootMagic Runtime Menu group box, then click Properties.

In step 4, partitions that cannot be hidden or visible are dimmed, preventing you from modifying their status.
For example, the partition the selected OS boots from cannot be hidden; therefore, it is dimmed; its status
cannot be overridden.

In step 3, when the Advanced Partition Hiding option is selected, BootMagic will hide all primary partitions
except for the one you are booting. When Advanced Partition Hiding is not selected, BootMagic will unhide only
the partition being booted. Advanced Partition Hiding is not selected by default.

Only partitions that are FAT, FAT32, HPFS, and NTFS may be hidden.

The Override Default Selections option is most useful for certain types of Windows NT installations. For
example, if your Windows NT boot files are installed on one primary partition, but all the remaining NT files are
installed to a different primary partition, BootMagic may not always make the second partition visible. Also, if
you have a primary data partition that you use with Windows NT, BootMagic may keep it hidden. By using
Override Default Selections, you can make these partitions visible and accessible when Windows NT is booted.



About Startup Delay

Use Startup Delay to specify the length of time BootMagic waits for an OS to be chosen before it automatically
boots the default OS.

{button ,JI("',"H_To_specify_a_startup_delay')} To specify a startup delay



To specify a startup delay
1 From the BootMagic configuration program, click Options ¥ Startup Delay.

2 Select the delay option you want from the pop-out list.
Del Description
ay
Opt
ion

Non Specify no startup delay;

e at startup, BootMagic
will immediately boot
the default OS.

Inde Specify an unlimited

finit delay; BootMagic will

e display the runtime
menu until you choose
the OS you want to boot.

Tim Specify a timed delay (1-

ed 99 seconds); BootMagic
will wait the specified
amount of time so you
can choose the OS you
want to boot. If you do
not make a selection
within the specified
time, the default OS is
used. A 30-second timed
delay is the BootMagic
default.

Tips

e You can also click the delay option you want from the Startup Delay group box.

¢ If you set the startup delay to either None or Timed, you must also ensure that a valid OS item is selected as
the system default. Without a default OS, BootMagic cannot automatically boot your system.

¢ If you set the startup delay to None and select a default OS that cannot run the BootMagic configuration
program, you will be unable to modify the configuration settings and boot other OSs. If this happens, boot your
computer while holding down the left Shift key. This overrides the timer settings and opens the BootMagic
Menu without a timer (as the indefinite option) for that one boot.
You can then select DOS or Windows from the BootMagic Menu, run the BootMagic configuration program, and
change either the default OS or the startup delay



About Advanced Partition Hiding

Use Advanced Partition Hiding to turn on or off support for secondary disk booting in BootMagic.

When the Advanced Partition Hiding option is selected, BootMagic will hide all primary partitions except for the
one you are booting. This option is not selected by default.

{button ,JI(*',"H_To_enable_advanced_partition_hiding')} To enable advanced partition hiding



To enable advanced partition hiding
1 From the BootMagic configuration program, click Options ¥ Advanced Partition Hiding.

Tips
¢ To disable advanced partition hiding, repeat step 1. Note, however, that you can change the visible primary
partitions on secondary hard disks only if this option is enabled.



About Set Configuration Password

Use Set Configuration Password to assign a configuration password. The password is used when you want to
start the BootMagic configuration program.

{button ,JI("',"H_To_set_the_configuration_password')} To set the configuration password



To set the configuration password

1 From the BootMagic configuration program, click Options k Set Configuration Password.

2 Type your old password (if available).
3 Type you new password, then type it again in the Confirm new password text box.

The next time you start the BootMagic configuration program, you will need to enter the password to access
the program.

Tips

¢ In step 2, the Old password text box will be blank and disabled if you have not previously set a password in
this dialog box. In such case, go to step 3.

¢ To disable the password setting, follow steps 1 and 2 above, but do not enter a new password.



About Set Boottime Password

Use Set Boottime password to assign a boot time password. The password is used when you want to start the
BootMagic Menu.

{button ,JI("',"H_To_set_the_boottime_password')} To set the boottime password



To set the boottime password

1 From the BootMagic configuration program, click Options ¥ Set Boottime Password.

2 Type your old password.
3 Type you new password, then type it again in the Confirm new password text box.

The next time you startup (or restart) your computer, you will need to enter the password to access the
BootMagic Menu.

Tips

¢ In step 2, the Old password text box will be blank and disabled if you have not previously set a password in
this dialog box. In such case, go to step 3.

¢ To disable the password setting, follow steps 1 and 2 above, but do not enter a new password.



About Change Background Bitmap

Use Change Background Bitmap to select the background bitmap (.BMP) image you want to display in the

BootMagic Menu background. For example, you could include your own company logo or a simple color
background.

The bitmap file should be 640x480 and can have up to 16 colors from the standard Windows 16-color palette.

{button ,JI(*',"H_To_change_the BootMagic_background_image')} To change the BootMagic background image



To change the BootMagic background image
1 From the BootMagic configuration program, click Options ¥ Change Background Bitmap.

2 Navigate to the bitmap image you want. The bitmap should be 640x480 with a .BMP file extension, and
can have up to 16 colors from the standard Windows 16-color palette.
3 Click OK.

The bitmap image you select will appear in the background of the BootMagic Menu at startup.
Tips

e |n step 2, click Default to use the default bitmap background image on the BootMagic Menu.



About Help

When you are in the BootMagic Configuration program you can get help by accessing Contents from the Help
pull-down menu. You can look up keywords in the Help Index or Find text in Help topics.

Additional Resources

The following additional resources contain information on installing, configuring, and using BootMagic.

¢ PartitionMagic User Guide - Your user guide provides explanations of the BootMagic tools and features. The
guide also provides step-by-step instructions on performing specific tasks.

e README.TXT File - BootMagic’s README.TXT is an invaluable resource for the most current information at
the time the product shipped. It includes information that may have changed since the user guide was
printed, corrections to the user guide or online Help system, and information specific to installation and
configuration issues.

To access README.TXT from the Windows taskbar, click Start ¥ Programs

» PowerQuest BootMagic
¥ Read Me, or you can access the file on your BootMagic rescue diskette.

¢ PowerQuest Web Site - PowerQuest’s corporate web site located at www.powerquest.com contains a variety
of information, including technical white papers, frequently-asked questions, support information, and news
about product updates.



Finding the Right Operating System

BootMagic lists all OSs detected on your system in the BootMagic Add OS dialog box. Occasionally though, an
existing OS may not be listed, an OS may be listed with an incorrect name, or a non-bootable partition may be
listed as containing an OS.

BootMagic uses a partition’s file system and boot record to detect an OS. After identifying the partition’s file
system, BootMagic looks at the partition’s boot record. If it finds a valid boot record, BootMagic assumes the
partition is bootable. It then uses the system filenames in the boot record to identify the OS. Using this method,
it is difficult to determine the difference between some OSs such as Windows 95, Windows 98, or MS-DOS.
Consequently, BootMagic may accurately detect a partition-based OS, but misname it in the Add OS dialog box.

In other instances, some data partitions may contain a boot record with OS system filenames, but not actually
contain a bootable OS. Because BootMagic uses the boot record to identify an OS, it will list an OS name for the
partition in the Add OS dialog box, even though the partition is not actually bootable.

If there are inaccurate entries in the Add OS dialog box, use the following information to help you distinguish
between OS entries and non-bootable partitions:

e The Add OS dialog box lists each detected OS and its volume name, partition type, partition, and disk
information. Because you know which OSs you have installed on which partitions, you can use this information
to identify a desired OS. For example, if you want to find a Windows NT OS that is installed on the first partition
of the first hard disk, you can look for an OS entry with a NTFS partition type, a Pri-1 partition, and a 1 disk.

¢ |If the OS you need is not listed in the Add OS dialog box, select Advanced to display all your system
partitions. You can then use the volume name, partition type, partition, and disk information to identify the
desired OS. For example, if you are looking for a Linux OS installed on the third logical partition of the second
hard disk, simply find the OS entry with an Ext2 partition type, a Log-3 partition, and a 2 disk.

e Occasionally, BootMagic may detect non-bootable partitions as containing an OS. This is due to the fact that
most data partitions are marked as bootable when they are created, even though there is no OS installed. For
example, if you have a primary NTFS data partition on the first disk, it may contain a boot record even though
the partition is not bootable. Because BootMagic uses the partition boot record to identify an OS, BootMagic
detects the partition as having a bootable Windows NT OS.

If a non-bootable partition has been added to the BootMagic Menu list by mistake, you can easily remove it.
Just identify the non-OS entry using the volume name, disk, partition, and partition type information listed in
the General tab of the BootMagic Menu Item Properties dialog box, then delete the non-bootable menu item
from the list.

For more information on menu item properties or removing a menu item from the BootMagic Menu, click See
Also on the Help toolbar.

¢ |f you have narrowed your search to two or three OS entries, but still cannot determine which is which, add the
OS entries to the BootMagic Menu. Reboot your computer, then select one of the unidentified OS items from
the menu. Once you see which OS (if any) is booted by the menu item, you can use the BootMagic
configuration program to rename the entry and change its icon. Repeat this process to identify any other
unknown operating systems.



About Installing a New Operating System

BootMagic makes installing multiple OSs on your system easy. Follow these general guidelines when installing a
new OS:

L]

Before installing any new OS, back up your system and make bootable diskettes for both your current OS and
BootMagic. Although the backup and boot diskettes may never be necessary, they provide a safety net should
any problems occur.

Some OSs require that you reboot your computer during installation. If this happens, you should reboot as
required. If the BootMagic Menu appears, you should boot from an existing OS. Run the BootMagic
configuration program, then add the new OS as a menu item to the BootMagic Menu. Reboot your computer
and choose the new menu item; this will continue the new OS installation.

If an OS installation gives you the option of installing the OS boot code to either the master boot record (MBR)
or the partition, choose the partition. Otherwise, the OS installation will overwrite the BootMagic MBR and
disable BootMagic.

If the MBR is overwritten by mistake, or if BootMagic fails to appear after an OS installation, you can easily fix
the problem by running the BootMagic configuration program (either from your hard disk or from the
BootMagic rescue diskette) and re-enabling BootMagic. When you save the configuration and exit the program,
BootMagic rewrites the MBR.

After installing a new OS, you must run BootMagic’s configuration program to add the new OS to the
BootMagic Menu. New OSs are not automatically added to the menu.

You can install an OS to a primary partition or a logical partition. If you plan to install either Windows NT or 0S/2
to its own partition, you should install to a logical partition. Note that Windows NT requires several boot files to
be located on a primary partition on the first hard disk.

{button ,JI("',"To_install_to_a_primary_partition')} To install a primary partition

{button ,JI("'," To_install_to_a_logical_partition')} To install to a logical partition



To install to a primary partition

1 Create the partition using PowerQuest PartitionMagic or a similar partitioning utility.

2 Make the primary partition active using PartitionMagic, PQBoot or PQBoot32 from Windows 95/98/NT.
3 When finished, reboot your computer and insert the OS’s installation disk.

4 Proceed with the installation as normal.

Tips

¢ If you plan to install either Windows NT or OS/2 to its own partition, you should install to a logical partition
instead. Note that Windows NT requires several boot files to be located on a primary partition on the first hard
disk.



To install to a logical partition

Windows NT

1 Decide which primary partition you want to have the Windows NT boot files located.

2 Make that primary partition active using PartitionMagic, PQBoot or PQBoot32 from Windows 95/98/NT.
3 Insert the Windows NT installation disk and reboot the computer.

4 Proceed with the installation as normal.

0S/2

1 Insert the OS/2 installation disk and reboot your computer.

2 Proceed with the installation as normal.

Tips
¢ Note that Windows NT requires several boot files to be located on a primary partition on the first hard disk.



Installation Issues for Specific Operating Systems
Click one of the links below for information on the installation requirements of a specific OS.
{button ,JI("',"H_DOS')} DOS

{button JI("',"H_Windows_3")} Windows 3.x
{button JI("',"H_Windows_95")} Windows 95/98
{button JI("',"H_Windows_NT')} Windows NT
{button JI("',"H_0S2")}  0S/2

{button ,JI("',"H_BeO0S')} BeOS

{button ,JI("',"H_Linux')} Linux

DOS

BootMagic supports the installation of most versions of DOS. In general, DOS must be installed on the first hard
disk and in a primary FAT partition that starts within the first 2 GB of the disk. To ensure proper operation with
BootMagic, we further recommend that DOS be installed completely within the first 2 GB of the disk.

BootMagic can boot some installations of DOS from a primary FAT partition on the secondary disk. For more
information, click See Also on the Help toolbar.

Some versions of DOS repartition, reformat, or otherwise reconfigure the hard disk during installation. This can
result in data loss on one or more of the disk’s partitions. Therefore, if prompted to partition, format, or configure
the disk during a DOS installation, deny the request.

If a DOS installation refuses to proceed unless it reconfigures the disk, you can try the following steps.
1 Exit setup.

2 At the A:\ prompt, type sYs <drive letter:>, where drive letter is the letter of the drive to which you are
installing DOS.

The SYS command copies the DOS system files to the disk.
3 Reboot your computer, leaving the installation disk in the floppy drive, and restart setup.

When it detects the system files on the disk, the DOS setup asks if you would like to replace the current
operating system. Select Yes, and proceed with the installation.

Windows 3.x

Windows 3.x cannot run as an independent operating system. Instead, it must run on top of an active DOS OS.
Consequently, Windows 3.x is limited by the same restrictions that apply to DOS (see above).

Because Windows 3.x is not an independent OS, BootMagic does not recognize it as bootable. In other words,
BootMagic will not boot directly to Windows 3.x. Instead, it boots the DOS over which Windows 3.x runs.

To boot Windows 3.x from BootMagic,
1 Add the DOS OS to the BootMagic Menu and boot to that DOS.
2 Use a text editor (such as EDIT.COM) to edit the AUTOEXEC.BAT file.
3 Add the WIN command as the last line of the file.
This command causes DOS to automatically launch Windows 3.x.
4 Run the BootMagic configuration program.
5 Rename the DOS OS menu item and change its icon to identify it as Windows 3.x on the BootMagic Menu.
6 Click Save/Exit.

Windows 95/98
In general, both Windows 95 and Windows 98 must be installed in a primary partition on the first hard disk.

NOTE: BootMagic can boot some installations of Windows 95/98 from a primary FAT partition on a secondary
disk. For more information, click See Also on the Help toolbar.

The Windows partition may be a FAT32 partition only if you are installing Windows 95B (sometimes referred to as
Windows 95 OSR2) or Windows 98.

During installation, Windows 95/98 replaces the master boot record (MBR), overwriting the BootMagic MBR. After



you install Windows 95/98, you can correct this problem, by running the BootMagic configuration program from
the home partition (that is, the partition in which BootMagic is installed)
1 From the Windows taskbar, click Start » Programs

» PowerQuest BootMagic

 BootMagic Configuration.

2 Select BootMagic Enabled to "turn on" BootMagic.
3 Click Save/Exit.

The configuration program rewrites the BootMagic MBR.
Tips

e |If you are not in the home partition, boot using the BootMagic rescue diskette, then follow the instructions for
running the BootMagic configuration program.

Windows NT

Windows NT can be installed in either a primary or logical partition on any hard disk; however, the NT boot
partition (in other words, the partition containing the boot files NTLDR, NTDETECT.COM, and BOOT.INI) must lie
completely within the first 2 GB of the first hard disk in a primary partition.

Windows NT 4.0 and earlier do not support FAT32, and therefore, cannot be installed on any FAT32 partition.

Windows NT can be installed in three different configurations:

¢ You can install all the Windows NT files in a single NTFS or FAT primary partition. This configuration is most
often used when NT is the first OS installed on a system.

e You can install most of the Windows NT files in a logical partition, but install the NT boot files within the first 2
GB of a visible, primary NTFS or FAT partition on the first disk. If you want to install Windows NT to its own
partition, this is the suggested configuration.

¢ You can also install Windows NT so that the boot files are placed in one primary NTFS or FAT partition on the
first disk, and the rest of the NT files are in another primary partition. Both partitions must be visible for NT to
boot.

If BootMagic does not automatically make the correct partitions visible, you can unhide the necessary partitions
using the Visible Partitions tab in the BootMagic Menu Item Properties dialog box.

0S/2

0S/2 can be installed in either a primary or logical partition on any hard disk; however, the boot files and system
partition must lie completely within the first 2 GB of the hard disk. OS/2 data partitions may be installed
elsewhere.

0S/2 must be installed on either a FAT or HPFS partition.

If you want to install OS/2 in its own partition, you should install it in a logical partition.

If OS/2 is installed to any partition other than a primary partition on the first disk, OS/2 requires Boot Manager to
be present during installation. However, once 0S/2 is installed, BootMagic detects the partition and Boot
Manager can be removed.

The OS/2 hard disk drivers may not support disks over 4 GB. If an error message appears during installation,
informing you that there is not enough free space on the disk or partition, you will need to download the 0S/2
drivers for large disk support. You can download these drivers at

ftp://ftp.software.ibm.com/ps/products/os2/os2ddpak/idedasd.exe.

BeOS

BeOS can be installed on any disk and in any primary partition, except for the home partition (that is, the
partition in which BootMagic is installed). BeOS partitions use the BeOS file system. To install BeOS, simply follow
the normal installation procedures.

Linux
Linux can be installed on any disk and in any primary or logical partition, except for the home partition (that is,
the partition in which BootMagic is installed). Linux partitions use the Linux Ext2 file system.

When installing Linux, do not install LILO in the master boot record (MBR); LILO will overwrite the BootMagic
MBR. Instead, install LILO to the Linux partition.



Do not set up partitions with Linux FDISK; it may render partition tables unreadable to other OSs. Linux FDISK
can be used, however, to change a partition type to Linux Ext2 or to swap partition types.

Do not set up partitions with Disk Druid as it may also render logical partition tables unreadable to some OSs and
hard disk utilities. However, Disk Druid can still be used to change partition types and set partition mount points.



Boot Operating Systems from Secondary Disks

BootMagic supports booting most OSs from second, third, or fourth disk and beyond. Some OSs, such as 0S/2,
Linux, and BeOS, are designed to boot from any disk. Others, such as Windows 95/98, Windows NT, and DOS, do
not commonly support secondary disk booting. For more information about installation issues specific to an OS,
click See Also on the Help toolbar.

If a specific OS does not support installation to a secondary disk, the OS can sometimes be installed on the first
disk, then copied to the secondary disk with PartitionMagic, Drive Image, or other hard disk utility. Once copied,
BootMagic detects the OS partition and boots it without problem. This method works with OSs such as Windows
95/98 and DOS.

Windows NT is the one exception. No NT configuration supports booting solely from a secondary disk. Even when
the majority of NT files are located on a secondary disk, the NT boot code must still reside on the first disk.

You should be aware that BootMagic does not hide or unhide partitions on any disk other than the first. Because
DOS, Windows 95/98, and OS/2 each require that they be the only visible, active, primary OS partition, only one
primary partition-based OS may be installed on a secondary disk. Additional OSs on a secondary disk will not
boot unless they can be installed to a logical partition or are manually hidden and unhidden at each boot
attempt.

BootMagic recognizes partitions on secondary disks and can even boot an OS from these disks; however, you

must consider the following restrictions:

e For DOS, Windows 95, and 0S/2, all primary partitions on all previous disks must be hidden before booting, you
should enable the option Advanced Partition Hiding in the BootMagic configuration program.



Using BootMagic with Other Programs

Dynamic drive overlay (DDO) software is often used to configure large IDE hard disks in situations where the
system BIOS limits disk capacity to 540 MB, 2.1 GB, or 4.2 GB. The DDO translates the disk into a configuration
that the BIOS can understand, allowing access to the full disk space.

BootMagic can be used with most DDO software. However, because the DDO determines how the BIOS interprets
your system disks and partitions, the DDO must be loaded before you install or run BootMagic. Otherwise,
BootMagic will not get the correct information from your disk and may even overwrite the drive overlay code.

Ontrack Disk Manager

BootMagic can be used with Disk Manager versions 6.03 and later. However, the following limitations must be
observed:

¢ Disk Manager must be installed using Ontrack Proprietary Format. Although Disk Manager can be installed with
either Ontrack Proprietary Format or BIOS Standard Format, BootMagic is only compatible with the Ontrack
format. BIOS Standard Format prevents the BootMagic loader from being installed and run at system boot up.

¢ Disk Manager cannot be installed on any disks other than the first. If Disk Manager is used on any other disks,
you will not be able to install BootMagic.

e Disk Manager must be loaded before you install or run BootMagic. To load Disk Manager, boot your system
from the hard disk (without a floppy boot diskette). If you need to boot from a floppy disk, wait until the
following message appears: "Press the spacebar to boot from floppy." Press <Space>, then insert the boot
floppy as instructed. When finished booting your system, install or run BootMagic as normal.

MicroHouse EZ-Drive

BootMagic is compatible with EZ-Drive versions 8.0 and later. If you have an older version of EZ-Drive, you
must either upgrade to a newer version or remove EZ-Drive from your system.

Before removing EZ-Drive, make sure your BIOS fully supports your system hard disks. Also be sure to back up
all information on the disk; once you remove EZ-Drive, all data on the disk will be lost.

EZ-Drive can be installed either with or without Floppy Boot Protection. Both installations are supported by
BootMagic.

EZ-Drive must be loaded before you install or run BootMagic. To load EZ-Drive, boot your system to the hard
disk (that is, without a floppy boot diskette). If you need to boot from a floppy disk, wait until the following
message appears: "EZ-BIOS: Initializing... hold the Ctrl key down for status screen or boot from floppy." Press
<Ctrl>, then insert the boot floppy as instructed. When finished booting your system, install or run BootMagic
as normal.

Anti-Virus Software

BootMagic is compatible with most anti-virus software (for example, Norton AntiVirus and McAfee VirusScan).
However, because these programs scan the MBR (master boot record) for viruses, they may interpret
BootMagic’s modifications to the MBR as a potential attack. If this occurs, do not attempt to repair the MBR using
the anti-virus software. You will overwrite BootMagic’s customized MBR and completely disable the program. If
necessary, most anti-virus programs let you manually disable MBR virus detection.

Some motherboards also contain virus protection software within the BIOS. This software can occasionally cause
problems by preventing BootMagic from making changes to the MBR. If this occurs, disable the virus warning
option in the CMOS setup of your system BIOS.



Frequently Asked Questions

| installed BootMagic, so why do | keep getting my old boot manager whenever | start my computer?
BootMagic cannot be used with boot management utilities other than Boot Manager. All other boot utilities must
be disabled or uninstalled before you install BootMagic. After you install BootMagic and restart your system, if
BootMagic is not the boot utility that first appears, disable the other utility and then run BootMagic’s
configuration program to re-enable BootMagic.

Why does BootMagic always boot to the operating system that | just installed?

Some OS installations overwrite the master boot record (MBR). If this occurs, BootMagic is disabled and your
computer boots to the last operating system you installed. If you have access to the \BTMAGIC.PQ directory, run
CONFIG.BAT under DOS or BMCFG32.EXE under Windows. Once in the configuration program, select BootMagic
Enabled, then click Save/Exit to restore the BootMagic MBR.

If you do not have access to the \BTMAGIC.PQ directory, you can use the BootMagic rescue diskette to run the
configuration program.

| installed a new operating system. Where is it?

BootMagic does not automatically incorporate a new OS into the BootMagic Menu; you must add it using the
configuration program. When you finish installing the new operating system and reboot your system, the
BootMagic Menu should appear. Boot an OS from which you can run the BootMagic configuration program. You
may also use the BootMagic rescue diskette to access the configuration program. Once in the configuration
program, add the newly installed OS to the menu list.

If the BootMagic Menu does not appear upon reboot, the new OS installation has probably overwritten the MBR.
See the question "Why does BootMagic always boot to the operating system that | just installed?" above for
more information.

For more information on adding an OS to the menu list, click See Also on the Help toolbar.

Why does my data partition appear as an operating system in the Add OS list?

If you have a primary NTFS partition on the first disk, it appears in the BootMagic Add OS list as Windows NT.
Depending on how you installed NT, this partition may or may not be bootable. If both the NT boot files and the
NT system files are installed in this partition, the partition is bootable. If the partition only contains NT data files,
it cannot be booted.

If you have a primary HPFS partition, it also appears in the BootMagic Add OS list, but as 0S/2. Again, this
partition may or may not be bootable. If 0S/2 is installed in the partition, it can be booted. If the partition only
contains data files, it cannot be booted.

Finally, primary FAT16 or FAT32 data partitions may appear as versions of DOS or Windows 95/98; however,
because these data partitions contain no OS, they are not bootable.

Extra OS listings may appear confusing, but the problem is easily resolved. Run the BootMagic configuration
program. Look through the listed OSs, using the disk and partition information in the BootMagic Menu Item
Properties dialog to distinguish bootable OS partitions from non-bootable partitions. As you identify each OS,
simply remove any unwanted or non-bootable entries from the menu.

For more information on distinguishing a bootable partition from a non-bootable partition, click See Also on the
Help toolbar.

Why is my operating system not in the BootMagic Add OS list?

BootMagic may not always detect all of the OSs that are installed. If your OS does not appear in the BootMagic
Add OS list, select Advanced to display all the partitions on your system. Select the partition that contains the
desired OS, and add it to the BootMagic Menu.

For more information on finding an OS that does not appear in the BootMagic Add OS list, click See Also on
the Help toolbar.

Why does the DOS OS installation tell me DOS is already installed?
Some DOS installations look at all visible partitions on your system; if they find another partition with the DOS



system files installed, you may get this message. To install the new DOS OS, hide all other partitions that contain
DOS system files, then install the new DOS OS.

My operating system used to boot, so why do | now get a "non-system disk" or similar error?

Some OSs, such as DOS and Windows NT, may stop booting if the partition crosses the 2.1 GB boundary. To
resolve the problem, move or resize the partition to below 2.1 GB.

After installation, why does the BootMagic Menu list more operating systems than | have?

After installation, BootMagic sorts through all your system’s hard disks, looking at the partition tables and
gathering information about each possible OS. While this method reliably detects most OSs, it may also detect
some non-0S partitions. For example, if you have a primary NTFS data partition on the first disk, BootMagic
detects it as Windows NT. Likewise, an HPFS data partition may be detected as 0S/2 and a FAT16 or FAT32 data
partition as MS-DOS or Windows 95/98.

After gathering all this information, BootMagic then adds every detected OS to the BootMagic Runtime Menu list.
If you click Save/Exit at this point, all the listed OSs will appear in the BootMagic Menu.

Extra OS listings may appear confusing, but the problem is easily resolved. Run the BootMagic configuration
program again. Look through the listed OSs, using the disk and partition information in the General tab of the
BootMagic Menu Item Properties dialog box to distinguish bootable OS partitions from non-bootable partitions. As
you identify each OS, remove any unwanted or non-bootable entries from the menu.

For more information on differentiating between OS partitions and non-bootable partitions, click See Also on the
Help toolbar.



Recovering a Failed Operation System

A working OS may suddenly stop booting if a disk crash, virus, or other error corrupts and destroys key system
files. You can resolve this problem by restoring or repairing the damaged files.

Before attempting to recover any non-working OS, first boot to the failed OS using the BootMagic Menu. This
ensures that BootMagic sets the corresponding partition active and makes all necessary partitions visible.
After booting using the BootMagic Menu, reboot your computer using the appropriate OS boot diskette. If an OS
boot diskette is unavailable, a DOS boot diskette may sometimes be used to examine system files and detect
potential problems.

Click the links below for information on basic recovery techniques for a specific operating system. If you have
questions about other OSs, consult the OS manufacturer’s documentation and support resources.

Do not use the BootMagic rescue diskette to restore system files.

{button ,JI("',"H_Recover_DO0S')} DOS

{button ,JI(*',"H_Recover_Windows_95')} Windows 95/98/Me

{button ,JI("',"H_Recover_Windows_NT')} Windows NT 3.51/4.0

DOS

MS-DOS requires a boot record and the following three files for proper operation: 10.SYS, MSDOS.SYS, and
COMMAND.COM. PC-DOS and other PC-type DOSs require a boot record and the following three files:
IBMBIO.COM, IBMDOS.COM, and COMMAND.COM. Both MS-DOS and the PC-type DOSs may also need
CONFIG.SYS and AUTOEXEC.BAT files. If present, these files may contain information required for DOS to boot
properly. All DOS system files are usually found in the C:\ root directory.

CONFIG.SYS and AUTOEXEC.BAT are both text files, and can be edited directly. The boot record and remaining
files can be restored from a diskette with an identical version of DOS. Boot from the diskette, then at the DOS
prompt, copy the needed files from the diskette. If it is necessary to restore the boot record, type SYS C: at the
DOS prompt (assuming C: is the DOS root directory).

When you finish examining and restoring the boot record and system files, remove the DOS boot diskette from
your computer and reboot to the OS through BootMagic.

Windows 95/98

In addition to the boot record, Windows 95/98 needs five working files to get to a DOS/Windows prompt:
CONFIG.SYS, AUTOEXEC.BAT, 10.SYS, COMMAND.COM, and MSDOS.SYS. These files are usually located in the C:\
root directory.

During the installation of Windows 95/98, users can create a start up diskette that will restore these system files.
This diskette should be used if you need to recover Windows 95/98.

If a start up disk is unavailable, you can create a Windows 95/98 boot diskette. Once you have a boot diskette,
the following information may help in recovering the needed system files.

Each of the five needed files should be examined to determine whether or not it is damaged. In general, the text
file CONFIG.SYS should contain a shell statement pointing to the Windows 95/98 subdirectory. Likewise, the text
file AUTOEXEC.BAT should contain a path statement, one portion of which points to the Windows 95/98 \
COMMAND subdirectory and not to the old \DOS directory. If needed, both of these files can be edited directly.
Some valid Windows 95/98 configurations may have empty or non-existent CONFIG.SYS and AUTOEXEC.BAT files.
These files are not always necessary for Windows 95/98.

If the 10.SYS or COMMAND.COM file is corrupt, you can copy these files from the Windows 95/98 boot diskette.
10.SYS is a hidden system file; you must use the ATTRIB -H command to make this file visible before it can be
copied.

If the wrong MSDOS.SYS file appears, be sure to search the entire disk for another instance of the file. If no valid
copy is found, copy this file from the Windows 95/98 boot diskette. MSDOS.SYS is a hidden system file; you must
use the ATTRIB -H command to make this file visible before it can be copied.

If you need to reload the boot record, but have a valid copy of MSDOS.SYS, you must first rename the
MSDOS.SYS file in the Windows 95/98 root directory. Otherwise, the SYS command used to load the boot record
will overwrite the MSDOS.SYS file with a useless copy.



Use the Windows 95/98 boot diskette to boot to the DOS/Windows prompt, then rename MSDOS.SYS (in this
example, C:\ is assumed to contain the hard disk Windows 95/98 root directory).

A:\> C:

C:\> ATTRIB -H -S -R MSDOS.SYS

C:\> COPY MSDOS.SYS MSDOS.TMP

Now reload the boot record with the following commands,
C:\> A:

A:\> SYS C:

Using the sys command may create an entirely new Windows 95/98 OS, leaving your old Windows OS still
unusable.

Finally, restore the correct MSDOS.SYS file with the following commands,
A:\> C:

C:\> ATTRIB -H -S -R MSDOS.SYS

C:\> COPY MSDOS.TMP MSDOS.SYS

When you finish examining and restoring the boot record and system files, remove the Windows 95/98 boot
diskette from your computer and reboot to the OS through BootMagic.

Windows NT 3.51/4.0

Windows NT requires three boot files: NTLDR, NTDETECT.COM, and BOOT.INI. Additional files, such as
CONFIG.SYS, AUTOEXEC.BAT, 10.SYS, COMMAND.COM, and MSDOS.SYS, may also be needed if you had MS-DOS
or another OS installed before you installed NT.

During the installation of Windows NT, users can create an NT repair diskette that will restore these system files.
This disk simplifies the correction of most basic NT problems.

For Windows NT 3.51, boot directly from the repair diskette. Follow the directions to restore your system files. If
you did not make a repair disk, the NT installation disk can be used instead. When you boot from the installation
diskette, you are prompted to either install NT or perform a repair. Select the repair option, then follow the on-
screen directions.

For Windows NT 4.0, use the three NT boot diskettes made during installation to boot into the NT Setup Program.
In the Setup screen, choose the option to repair the current NT installation. Insert the NT emergency repair
diskette when prompted, then follow the on-screen directions to restore your system files.

When you finish all necessary repairs, remove the Windows NT diskette from your computer and reboot to the OS
through BootMagic.



Error Messages and Solutions

BootMagic error messages and possible solutions are listed below by number. The messages are also grouped
into number ranges using the following categories:

{button ,JI("',"H_Error_General')} General (8000-8049)

{button JI("',"H_Error_Menu_Item_and_Configuration')} Menu Item and Configuration (8050-8099)
{button ,JI("',"H_Error_Boot')} Boot (8100-8149)

{button ,JI("',"H_Error_File_and_Disk_I0")} File and Disk I/O (8150-8199)

{button ,JI("',"H_Error_Parser_Read_Write')} Parser Read/Write and General (8200-8249)

{button ,JI(*',"H_Error_Partition_Table')} Partition Table and Boot Record (8250-8274)

{button ,JI("',"H_Error_BootMagic_Configuration')} BootMagic Configuration (9000-9499)

If you encounter an error that is not discussed in this topic, visit PowerQuest’s website at

http://support.powerquest.com for a complete listing.

General Errors (8000-8049)

# 8001 Error allocating memory: Need <number> bytes more memory

This error can occur when the number of OS items in the BootMagic Menu requires more memory than is
available. To solve this problem, simply run the configuration program, and delete one or more OS items from
the menu list.

Menu Item & Configuration Errors (8050-8099)

#8050 No default menu item available to boot

This error usually occurs when you have set the Startup Delay to None or Timed, but have not selected a
default OS. To resolve the problem, run the BootMagic configuration program, and then select a valid OS item
as the system default.

#8051 Error finding operating system for menu item
BootMagic cannot boot the OS for a listed menu item, a situation that usually means the OS has been deleted
from the partition. After displaying this error message, you should run the BootMagic configuration program,
and the menu item will be automatically removed from the list. Save the change and exit the configuration
program to return to the BootMagic Menu.

Occasionally, however, this error message appears even when a valid OS is present. If this is the case, simply
run the configuration program again and re-add the OS to the menu.

#8054 No menu item entries found in configuration file

The configuration file is either empty or corrupted. Run the BootMagic configuration program and, after
deleting any listed items, re-add all desired OSs to the menu.

#8055 The master boot record file <filename> is too large

BootMagic operates by replacing your system’s MBR (master boot record) with a version configured to load
and run the BootMagic program at startup. This error message appears if the file containing the boot code for
the BootMagic MBR loader is too large. Reinstall BootMagic so that the file is rewritten with the proper
contents.

Boot Errors (8100-8149)

#8109 Unable to find partition for menu item: <menu item>

BootMagic cannot find the partition for a listed menu item, a situation that usually means the partition has

been deleted. After displaying this error message, BootMagic automatically runs the configuration program
and removes the faulty menu item for you. Save the change and exit the configuration program to return to
the BootMagic Menu.

Occasionally, however, this error message appears even when a valid partition and OS are present. If this is



the case, simply run the configuration program again and re-add the OS to the menu.
File and Disk 1/0 Errors (8150-8199)

#8150 Open file failed on file

BootMagic cannot open a needed file. Attempt to fix the problem by simply launching the configuration
program, then clicking Save/Exit. If that proves unsuccessful, re-install BootMagic.

#8151 Create file failed on file

BootMagic cannot create a necessary file. This error may mean you are out of disk space; create additional
space either by deleting unnecessary files or by making the partition larger.

#8152 Read file failed on file

BootMagic cannot read a necessary file. Attempt to fix the problem by launching the configuration program,
then clicking Save/Exit. If that proves unsuccessful, re-install BootMagic.

#8153 Write file failed on file

BootMagic cannot write needed information to a file. This error may mean you are out of disk space; create
additional space either by deleting unnecessary files or by making the partition larger.

#8155 Error opening drive

BootMagic cannot open the necessary disk, and therefore cannot launch the configuration program. If you are
running Windows NT or Windows 95/98, close all other programs and disk utilities, then run the configuration
program again.

#8156 Error getting drive geometry

BootMagic cannot detect the needed disk geometry, and therefore cannot launch the configuration program. If
you are running Windows NT or Windows 95/98, close all other programs and disk utilities, then run the
configuration program again.

#8162 EZ-Drive has been installed on this disk, but is not loaded. Load EZ-Drive and then rerun
BootMagic install.

If EZ-Drive is installed on your hard disk, it must be loaded before you can install BootMagic. Otherwise,
BootMagic could potentially overwrite the disk overlay code. To solve this problem, reboot your system to the
hard disk (without a floppy boot diskette) so that EZ-Drive is loaded properly. If you need to boot from a floppy
disk, wait until the following message appears: "EZ-BIOS: Initializing... hold the Ctrl key down for status screen
or boot from floppy." Press <Ctrl>, then insert the boot floppy as instructed. When finished booting your
system, install BootMagic as normal.

#8163 Disk Manager has been installed on this disk, but is not loaded. Load Disk Manager and
then rerun BootMagic install.

If Disk Manager is installed on your hard disk, it must be loaded before you can install BootMagic. Otherwise,
BootMagic could potentially overwrite the disk overlay code. To solve this problem, reboot your system to the
hard disk (without a floppy boot diskette) so that Disk Manager is loaded properly. If you need to boot from a
floppy disk, wait until the following message appears: "Press the spacebar to boot from floppy." Press
<Space>, then insert the boot floppy as instructed. When finished booting your system, install BootMagic as
normal.

#8164 The configuration of Disk Manager on this drive prevents BootMagic installation.
Disk Manager is installed on the disk using BIOS standard format. This format is incompatible with BootMagic.

#8166 Error writing sector number.
This error may be caused by any of the following:

o |f this error message is preceded by a black box and/or several beeps, you need to disable the virus warning in
the CMOS setup of your system’s BIOS Features menu. If the virus warning is disabled and this error still
occurs, your hard disk may be defective. Use a disk-checking utility (for example, SCANDISK, or CHKDSK) to



detect any problems.

¢ Installing BootMagic while in Windows sometimes causes this error. If this is the case, exit to DOS and install
BootMagic from there.

¢ Launching the DOS configuration program while in Windows sometimes causes this error. If this is the case,
exit to DOS and run the configuration program from there.

¢ Anti-virus software or hard disk overlays may cause this error. If the problem is an overlay, BootMagic is
probably incompatible with the disk translation software that created the overlay. For more information on
software interactions, click See Also on the Help toolbar.

#8168 Error loading file PQVXD.VXD

PQVXD.VXD is needed by Windows 95 to access the hard disk. The Windows 95 configuration was either
unable to find this file, or the file is corrupted. Re-install BootMagic to replace the file.

Parser Read/Write and General Errors (8200-8249)

For all errors in this number range: run the configuration program, then re-add any lost menu items to the
BootMagic Menu. Save your changes and exit.

Partition Table and Boot Record Errors (8250-8274)

#8255 Error writing master boot record
This error may be caused by any of the following:

¢ |f a black box and/or several beeps precede this error message, you need to disable the virus warning in the
CMOS setup of your system’s BIOS Features menu. If the virus warning is disabled and this error still occurs,
your hard disk may be defective. Use a disk-checking utility (for example, SCANDISK, or CHKDSK) to detect
any problems.

¢ Installing BootMagic while in Windows sometimes causes this error. If this is the case, exit to DOS and install
BootMagic from there.

¢ Launching the DOS configuration program while in Windows sometimes causes this error. If this is the case,
exit to DOS and run the configuration program from there.

¢ Anti-virus software or hard disk overlays may cause this error. If the problem is an overlay, BootMagic is
probably incompatible with the disk translation software that created the overlay. For more information on
software interactions, click See Also on the Help toolbar.

#8256 Unable to write BootMagic loader to MBR, not enough free sectors.

BootMagic operates by replacing your system’s master boot record (MBR) with a version configured to load
and run the BootMagic program at startup. This error message appears if there are not enough free sectors at
the beginning of the hard disk for the BootMagic loader to be installed. If the hard disk was previously
configured with a disk overlay that you are no longer using, some portion of that overlay may still be present.
Use the overlay program’s setup software to uninstall the overlay completely, and then try again to install
BootMagic. If this does not work, or if a disk overlay program was never used, contact PowerQuest’s technical
support department. For more information on contacting technical support, click See Also on the Help toolbar.

BootMagic Configuration Errors (9000-9499)

#9002 Unable to find operating system for the menu item: <menu item>. This menu item will be
removed.

BootMagic cannot find the OS for a listed menu item, a situation that usually means the OS has been deleted.
After displaying this error message, BootMagic automatically removes the faulty OS item from the menu list.

Occasionally, however, this error message appears even when a valid OS is present. If this is the case, simply
re-add the OS to the menu.

#9004 Invalid icon file for menu item: <menu item>
The file selected is not a valid icon file. Choose a new icon file for the menu item.






Using the WRPROG.EXE Utility

WRPROG.EXE is a DOS utility that you can use to backup and restore the first track (first head) of a hard disk.
This is useful when there is a need to remove information from the first head, or if you just want to make a
backup. WRPROG is the utility that BootMagic uses to install and uninstall its loader program.

Syntax
WRPROG [switches] filename

Switch Description
es
/bak Back up all of the

sectors in the first
head to the file

specified by
filename.
/rst Restore all of the

sectors in filename
to the first head.
This will overwrite
existing
information. Use
this switch with
caution; it may
cause all partitions
on the disk to
become
inaccessible.

If you use WRPROG without a switch, the program will restore the first 446 bytes of filename to the MBR (master
boot record); the partition table will not be overwritten. This is effective for removing or replacing the BootMagic
loader.



To create a diagnostic report

You can run PARTINFO to generate a diagnostic report showing the contents of your hard disk partition. This
information is helpful in fixing various partitioning problems and is used by PowerQuest technical support to
resolve problems you encounter while using BootMagic.

You run PARTINFO.EXE from the \BTMAGIC.PQ directory after you install BootMagic.
1 Boot the computer to DOS.
2 Run the PARTINFO option you want.

To Type

Display PARTINFO, then press
partitio <Enter>.

n

informa

tion on

your

screen

Send a PARTINFO >LPTI, then
report press <Enter>.
directly

to your

printer

Save PARTINFO >A:\

the PARTINFO.TXT, then
report press <Enter>.

as a

text file

on a

floppy
disk



PowerQuest Technical Support

Before contacting PowerQuest, please try to resolve problems you encounter by using the online Help, the user
guide, the README file, and PowerQuest's corporate web site.

Tips

¢ Your problem may be resolved by applying the most recent patch or upgrade of the software. You can
download patches and upgrades from http://www.powerguest.com/updates.

¢ PowerQuest technical support engineers may request information from the PARTINFO utility program to help
you resolve problems with PowerQuest software. The PartitionInfo report is always required for errors 100-199,
255, 986, and drive detection errors of any kind.

e Your product serial number is required to obtain technical support.

¢ |f you received a demo or trial version of the PowerQuest software, you are not entitled to complimentary
technical support.

Term of Technical Support

Technical support is available to all registered users throughout the life of the product, which began when
PowerQuest released the software to manufacturing and ends six months after the release of the next version of
the software or when PowerQuest discontinues its development.

Upon registration, PowerQuest provides 45 days of complimentary technical support from the day of your first
call.

Corporate Web Site

The Technical support web site, http://support.powerguest.com, includes an overview of support options, an e-
mail support request form, a list of error messages and information to resolve problems you encounter, and
answers to frequently asked questions about the product.

E-mail
Lang E-mail address (for
uage specific technical

problems)
Dutc eurots@powerquest.com
h
Engli help@powerquest.com
sh eurots@powerqguest.com
Frenc  france@powerquest.com
h
Germ germany@powerguest.c
an om
Italia italian@powerquest.com
n
Portu  latina@powerguest.com
gues
e
Span spanish@powerquest.co
ish m

To obtain e-mail technical support for specific technical questions, you can fill out the form at
http://support.powerquest.com (available in English only). If you send the information from PARTINFO with your
e-mail message, a PowerQuest technician will be able to assist you more easily. Refer to the product user guide
for information about PARTINFO.



E-mail on Demand

PowerQuest maintains an e-mail on demand system to resolve common problems. You can view a list of available
documents at http://support.powerquest.com. To request one of the documents, send an e-mail message to
support@powerquest.com with the index number of the document in the subject of the message. You can only
request one document per e-mail message. E-mail on demand documents are available in English only.

Fax

Loc Number

atio

n

USA +1(801) 437-
4218

Eur +31 (0)20 581

ope 9270

Fax a description of your problem to the technical support fax number. This service is available in the United
States, Canada, and Europe 24 hours, 7 days. PowerQuest technicians try to respond to all fax requests within 24
hours.

Telephone
Lang Location Number
uage
Dutc Netherland 431 (0)20 581 3906
h s
Engli Netherland  +31 (0)20 581 3907
sh s
Engli UK +44 (0)17 1341 5517
sh
Engli USA +1 (801) 226-6834
sh
Frenc France +33(0)1 69 3249 30
h
Germ Germany +49 (0)069 66 568
an 516
Italia Italy +39 (0)02 45 28
n 1312
Portu USA +1 (801) 226-6834
gues
e
Spani Spain +34 (0)91 622 3146
sh
Spani USA +1 (801) 226-6834
sh

The USA call center is open Monday through Friday, 7:00 a.m. to 6:00 p.m., MST/MDT. Our European call centers
are open Monday through Friday from 9:00 to 18:00, CET.

If you have the information from PARTINFO ready when you call, a PowerQuest technician will be able to assist you
more easily. Refer to the product user guide for information about PARTINFO.

Postal Service Mail



USA Europe

PowerQuest PowerQuest

Corporation Customer
Service

P.O. Box 1911 P.O. Box 58287

Orem, Utah 1040 HG

84059-1911

U.S.A. Amsterdam
The

Netherlands

Please include the information from PARTINFO with a description of your problem. Also include a return address, a
daytime phone number, or other relevant contact information.
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